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_rasm. Android arxitekturasi

: . alga oshiriladi va qurilmaning o°ziga xos
. M{tubxonala;ogci;; ,i?;;mqiﬁ‘;‘adi‘ ular bilan ishlab chigaruvchi
uskunasi uchun :‘matﬂéﬂﬂ shaklda tagdim etiladi. Android OTda
. galanadigan kutubxonalari quyidagicha: e
Whmd Surfe ?Mmm“g?ﬁom:ozu oynalar boshqaruvchmdlr.. K'xruvchx
buyr liribufadaro‘phnddi. ular ma’ lum kompozitsiyani tashkil giladi va
kegr:ql fa ko'-mitihdi Bu tizimga giziqarli uzluksiz effektlar, oyna
shaffofligi vasilliq o*tishlarni yaratishga imkon beradi. ;
" Media Framework — PacketVideo OpenCORE asosida amalga
Tiril kutubxonalar. Audio va video kontentni yozib olish va namoyish
etish, shuningdek, statik tasvirlami ko'rsatish uchun ishlatiladi. Qo*llab-
quyvatlanadigan formatlar: MPEG4, H.264, MP3, AAC, AMR, JPG va
PNG.
 S0Kite—bu Android tomonidan asosiy ma’lumotlar bazasi mexanizmi
sifatida ishlatiladigan engil va kuchli relyatsion ma’lumotlar bazasi
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M&WWM—&W tezlashuvidan foydalangan holda 3D
iarmi vugor darajada. optimallashtirilean tarzda ko‘rsatish uchun

2}

ishlatiladi. Kutubxenalar OpenGLIES AP[ asosida amalga oshiriladi
6panL|ES (O matilgan tizimlar uchun OpenGL) o'matilgan tizimlarda
ishlashga moslashtirilgan OpenGL grafik dasturlash interfeysining Kichik

to*plamidir. =y ; i :
lreeType — bitmaplar bilan ishlash, shriftlami rasterlash va ular ustida

allamni bajarish uchun kutubxona.
LibWebCore —bu WebKit brauzerining kutubxonasi bo*lib. u mashhur
Google Chrome va Apple Safari brauzerlarida ham qo®llaniladi.
SGI (Skia Graphics Engine) — 21 grafikalar bilan ishlash uchun ochiq
Kkutubxona. Bu kutubxona Google mahsuloti ba’lib, ko'pincha boshga

dasturlarda qo*Haniladi.
§s2 — xuddi shu nomdagi kriptografik protokolni go*lab-quvvatlash

uchun kutubxonalar.
Libe — bu C standart kutubxonasi. ya’ni uning BSD ilovasi, Linux-ga

asoslangan qurilmalarda ishlash uchun tuzilgan.

Dasturning bajarilish muhiti Java tilining asosiy kutubxonalari uchun
mavjud bo‘lgan past darajadagi funksionallikning ko'p  gismini
ta'minlovchi yadro kutubxonalarini va tlovalarni ishga tushirish imkonini
beruvchi Dalvik virtual mashinasini 0°z ichiga oladi. Har bir dastur o*ziga
<os virtual mashinadaishlaydi va shu bilan ishlaydigan ilovalarni operatsion
tizimdan va bir-biridan ajratib turadi. Dalvik virtual mashinasida ishlash
uchun Java sinflari Android SDKga Kiritilgan dx vositasi yordamida
bajariladigan .dex fayllariga Kkompilyatsiya qilinadi. DEX (Dalvik
I Xecutable) — bu Dalvik virtual mashinasi uchun minimal xotiradan
foydalanish uchun optimallashtirilgan bajariladigan fayl formati. Eclipse
IDE va ADT (Android Development Tools) plaginidan foydalanilganda
Java sinflari avtomatik ravishda .dex formatiga kompilyatsiya gilinadi.

Android Runtime arxitekturasi shundan iboratki, dasturlarning ishi
gat’iy ravishda virtual mashina muhitida amalga oshiriladi, bu OT yadrosini
uning boshga komponentlari tomonidan mumkin bo*lgan zararlardan
himoya qilishga imkon beradi. Shuning uchun, xato kodi yoki zararli
dasturlar ishlaganda Android va unga asoslangan qurilmani buza olmaydi.

Arxitekturasi har qanday dasturga Kirishga ruxsat berilgan boshqa
ilovalarning allagachon amalga oshirilgan imkoniyatlaridan foydalanishga
imkon beradi. Uni tarkibiy qismlari 0°z ichiga quyidagilarni oladi:

~ ro“yxatlar, matn maydonlari, jadvallar, tugmalar yoki hatto o* rnatilgan
veb-brauzer kabi vizual ilova komponentlarini yaratish uchun ishlatilishi
mumkin bo*lgan kengaytiriladigan Views to*plami (Viewlar),
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chiqish uchun zarur bo‘lgan minimgj
o uchun dadturiy vosttani ishlab chigishda
Sm“mgwsiﬁm kerak bo'lsa. ulami ishla

ADT m}':w kfmom va ularni muhitga qo'shish mumkin

€ ot © vpor - e,

- da kichik muammo yuzaga kelishi mumki!\: agar kompyuterda 1D
B:-n:ﬁmngﬂ“ bo'lsa. muhit ishga tushmaydi va JDK jildiga w‘l':i
belgilashni yoki uni o'matishni talab giladi. JOK ni Oracle web-saytian
vuklas- olish mumkin (2.3-rasm). JDK ni yuklab olish uchun ayval lise

“hartmomasi
(2.4-rasm)-

shartlarini gabul qilish va keyin kerakli versiyani tanlash kélryat

o
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2.2-rasm. Dasturchi sayti
>34 PN PR320 )ed N (1 ke e P SR T ot s ] 8 3 6 e

itani yuklab olish uchun litsenziya shartnomasi shartlarini

2.4- 1 vukl g
| wﬂ‘ i (32-bit yoki 64-bit) tanlash kerak 2.4-rasm. JDK ni yuklab olish

Yuklab olingandan so‘ng. o'matish faylini ishga tushirish va JDK ni
o'matish kerak. JDK o‘matilgandan so‘ng, muhit ishga tushishi kerak.
Keyinchalik, ish joyini ya'ni loyihalar joylashadigan joyni tanlash (yoki
yangi joy yaratish) kerak. Agar u belgilansa, bu ish maydoni sukut bo*yicha
tanlanadi, aks holda bu oyna AndroidStudioni har ishga tushirganda paydo
bo‘ladi. Keyin ishlab chiquvehilar SDKni yanada yaxshilash uchun statistik
ma’lumotlarni yuborishni taklif giladigan oyna paydo bo‘ladi. Bu oynada
rozi bo'lish uchun belgilashni bosish yoki rad gilish mumkin.

Asboblar panelidagi Android SDK menejeri belgisiga etibor berish
lozim (shuningdek, Window menyusida mavjud). Uning yordamida
foydalanuvchi o‘z muhitida yangi vositalarni qo'shishi mumkin. Bu
darchada shuningdek, o‘rnatilgan vositalarmi ham ko'rish mumkin. Har bir
vosita ro‘parasida uning o‘rnatilganligi yoki o'rnatilmaganligi haqidagi
statusi turadi. Shuningdek, har bir vositaning API darajasi ham akslanadi
(2.5-rasm),

Oracle veb-sayti

joylashtirmogchi bo‘lgan papkani
o‘matishnj talab gilmaydi). Paketni
10'tish va AndroidStudion; ishga tushirish lozim.
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2.5-rasm- Android SDK menejeri
[Ill,lw"wal'“;, MZZ: }f";;:lmcm usidagi New->New Project buyruglar
lm‘-}-m‘-h ‘1:‘;5 Keving qad;mda New Project darchasi ochiladi, Bu
W"“}"ﬁ' :ﬂwh; schun “Phone and Tablet”, “Wear OS”, “Android
m '(3\vmm01ive" po limlarini taklif etiladi. Foydalfmuvchl. l?u
bo'fimlardan ixtiyoriy shablonni tanlash va tayyor shablonlar bilan tanishib
w-yﬁi‘l:t‘ bo'limda “Ne Activity”, “Empty (omposo~
Activity”, “Empty Compose Activity (Material3)”, “Empty Activity”,
“Fullscreen Activity”, “Google AdMob Ads Activity”, “Google Maps
Activity”, “Google Pay Activity”, “Login Activity”, “Primary /Detail Flow”,
“Navigation Drawer Activity”, “Responsive Activity”, “Settings Activity™,
“Scrolling Activity”, “Tabbed Activity”, “Fragment+ViewModel” va
“Native C++ turidagi shablonlar mavjud.

“Wear 05™ bo'limda “No Activity”, “Blank Activity” va “Watch
Face™ turidagi shablonlar mavjud.

“Android TV" bo'limda “No Activity” va “Blank Activity” turidagi

M-s:vw" bo'limda “No Activity”, “Media Service” va
Messaging Service” turidagi shablonlar mavijud.

Lﬂu’ - H

interfe

ablonlardan foydalanganda fagat shy Ko’ rinishdae;
shdagi

celtirilgan sh ! lar ‘
K h imkonini beradi (2.6-rasm)

v\'lnmi yaratis

2.6-rasm. llova yaratish

Keyingi gadamda ilova nomini, loyihani saglaydigan joymi va paket
nomini, SDKni minimal versiyasi va dasturlash tilini tanlash lozim. Bunda
loyiha nomini berilgan nom bilan goldirmaslik yaxshirogdir, chunki bunday
nomdagi paketni Google Play-ga joylashtirish mumkin emas. Albatta, u
yerda ta’lim dasturlari yuklanmaydi, ammo kelajakda buni yodda tutish
kerak. Dasturlash tili sifatida Java va Kotlin tillari taklif e\{ladi. SDKni
minimal versiyasi sifatida Android 5.0 versiyasi taklif etiladi (2.7-rasm).

Minimal talab gilinadigan SDK - ilova qo‘llab-quvvatlaydigan
Androidning minimal versiyasi hisoblanadi. Ko'pincha, iloji t;orizha
ko*prog qurilmalarni qo*llab-quvvatlash uchun Android 5.0 versivasi sukut
bo‘yicha belgilanadi. Agar ilovaning ma’lum funksiyasi fagat Ar;droidning
yangi versiyalarida ishlayotgan bolsa va bu ilovaning asosiy funksiyalari
to*plami uchun muhim bo‘Imasa, uni qo*llab-quvvatlaydigan versiyalarda
opsiya sifatida belgilash mumkin. :

. Target SDK — ilova yoziladigan Android versiyasi; ilovani sinab
ko'rilgan Androidning maksimal versiyasini moslik rejimlari uchun
belgilaydi.
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a Android ﬁmkSiya'ari“i"g qaysi versiyasidap

wmpie With = ilov:
ipss jaydi

ﬁ)}-dalanishiﬂl. aniq

2 7-rasm. loya nomi

Keyingi oynani o' zgartirishlarsiz o'tkazib yuborish mumkin. Bu
ym-shmiy ishga tushirish belgisini yaratish — ilova belgisini yaratish
mumkin. Activity yaratish — faollik. mobil ilova oynasi. formasini yara;j;h
nuin Ush&loyiba kutubxona sifatida belgilanadi. ya'ni loyiha p(,k(;,

ﬁ i - .A - :
Create Project in Workspace — Workspace papkasida loyi :
s Pmy:; bmu orksmc;q lamfvpua papkasida loyiha yaratish.
| ,}(qm'gg qadmi: iggmg;qulta yaratish }!isoblanadi. Bunda standart
m&onﬁgmts. tigr mngamqoi’ _.yt.)kloz-konﬁgumtsnymniyaralish mumKkin. Bu
isoda rang ssemasi, shakli o'zgartrildi va clipartdagi ras :
i g G, gi rasm tanlangan.
Aoty P&W&b Aﬂd‘_ Uldi Kc?qu?km‘ga (shakl, oyna) ega bo'lib, ular
Birinchisini ‘w eyingi ikkita oyna bosh Activity-ni y '
Birinchisini o'zgartirish i Dp'siy Activiyni yaratadi,

S S A kerak emas. Ikkinchisid: Vi i
zganinsh ,mthm Blank Activity ~ mobi) telef ida Activity nomini
shablon, To'liq ekran Activity — fovani il telefonlar uchun mo°ljallangan
beruvehi shablon (naviga ity ~ tlovani to°lig ekranga cho‘zish i A
e ';h hkm (e h s meuc)i va holt ,g;a cho'zish imkonini
' - planshet kom : a holal panelisiz). Master/Detai
pyuterlar uchun mo‘ljallangan shablon s
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shunday mrt_ipda mohil !lova loyihasini yaratish :
ash(’b“‘r :o.‘p!a{nlnnng l(?‘g'rl S natibshin -l&kshir' ;:\umkm. Albitta, b
Jastur asosiy hisoblanadi. ammo unda Ko*plab ilov:‘ uchun Q'Yl\iiflltx—‘,r\\
Loyiha lshgﬂ‘“.'shgi‘“da"_ keyin uni tarkibini chap :" gRah '““mi'm

da ko‘rish mumkin. Bu maydonda loyihu(ljag;n;:“n“‘a joylashsan

archa fayllar ‘L\S

maydon

cniriladi (2‘8-msm).

- 8 as - & )
— ibl 1- ¢ as i
e £ asm tanlas h roki \{Aﬂ!_'.iSini val 'tﬁ\'h Oy 3
I n. R SNV TS ynasi

Activity fayli pak Gt
“ 3 » iKeldag e <3 e
ega (2.9-rasm) !I:)‘\'ih d(?tl '\.'L-“lldl.dd-lo-\.h““hg"“" U * java ke :
) - L 2 ani kor‘ishning bir nechta \ur‘lr engaytmasiga
: . Packages, Project Fi . ¢ mayjud: :
Files. Open Fii"gt ﬂ'(”“lhle‘\‘P'"'lc’c'tS‘,mrce Files. P T“J\ld' Project,
5 7 ex va Scratches ana > T es, Project Non-Sour
s and Consoles (2 eciyon-source
~onsotes (2.10-rasr
: S ).
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stki kasidagi res papkasida Activity-nin Pt ‘
I‘“'.'z::v';?;;_kA%Zn shu fayl qurilma ckranida kO“rinfd‘?gangh:ﬁ;(:f’dn
xml ra)"lll fayllari bilan grafik muharrir rejimida ham ishlash vy Kodni
‘l’: tahrirlash mumkin.. Su‘kut h()‘yi-Cha activity main xmi S
lrc\"’?'adi va unda xml versiyasi va kodirovka, Constrainifayey, =
}"3“'",'-_, » elementlari mavjud bo*ladi (2.1 1-rasm).
Tex: L(u ;m".a,-,,,l_a).-uul-da uning balandligi va eni, qo*laniladigan konten
0 ﬁ;o(lar joylashdi, Har bir clement teg ichida joylashadi. Bundan ‘
e lovihada build gradle(app) va build gradle(Modul) faylari mavjug
e hq; r:ﬂa;- o‘zida loyiha konfiguratsiyasi hagidagi ma’ lumotlarmi Sﬂqlai-d'\
bohfa‘yuarga loyihaga yangi malcr.iallar va ‘komponcntnlar_ Phigi'nlar
B:-qhg.anda o‘zgartirishlar avtomatik yoki foydalanuvchi
Eirililadi.

e

tomonidan
5 tivity varatish
2 G_rgsm Activity )

2.1 1-rasm. Xml fayli

llovani emulyatorda ishga tushirish uchun qurilma emulyatorini
yaratish kerak (2.12-rasm). Buni asboblar panelidagi smartfon tasvirlangan

tugmani bosish orqali amalga oshirish mumkin. Agar wgma panelda
bo*Imasa, uni Window menyusida topish mumkin.

2.10-rasm. Loyiha tarkibi
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2.1 2-rasm. llovani ishga tushirish

hasi ochiladi. Birinchi marta
Joanda unda bitta ham virtual
qurilma mavjud bo‘lsa u ro‘yhatda

Manager darc

pndroid Virual Device MOWEE i

i jice Manage”
droid Virtual Device M
éﬁ‘n'ilrr:na bo'Imaydi. Agar virtual
akslanadi (2 | 8-rasm).

2.18-rasm. Android virtual qurilmalar menejeri

Virtual qurilma yaratish uchun Create Device tugmasini bosish lozim.
Virtual qurilmani yaratish oynasi paydo bo‘ladi. Bu oynada qurilmaga nom
berish va kerakli xususfyatlarni tanlash kerak: Qurilma maydonida —
qurilmaning modeli tanlanadi. Keyin qurilmaning ekran o‘lchami tanlanadi,

50

Shuningdek go‘shimeha parametrlarni o‘zgartirish mumkin: SD-Kartaning
Shuni + 40 S , ; 5 10
o' lchami o‘rnatilgan xotira va boshqalar (2.19-rasm).

2.19-rasm. AVD vyaratish

Keyingi gadamda dasturni ishga tushirish mumkin. Buning uchun
asboblar panelidagi Run tugmasini (yashil doiradagi oq uchburchak) bosish
lozim. Dasturni ishga tushirishdagi muammolarni konsolda kuzatish
mumkin, Agar dastur ishga tushmasa, “Ishga tushirish” tugmasining o*ng
tomonidagi qora uchburchakni bosib “Konfiguratsiyalarni ishga tushirish™
buyrug-ini tanlab, so*ngra “Run” yorlig‘ida yaratilgan qurilma tanlanadi va
loyiha qayta ishga tushiriladi (2.20-rasm).

2.20-rasm. llovani ishga tushirish

Har bir buyruq to'g’ri bajarilgan bo‘lsa, emulyator ishga tushishi
kerak. Ishga tushirish vaqti kompyuterdagi RAM migdoriga bog'liq. Dastur
ishlayotgan paytda emulyatorni yopish mumkin emas, u ilovalar ishlaydigan
rejimda ishlaydi (2.21-rasm).
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in. ucomm» mgmasini bosish va Pa)'do bo\‘
maydonigs Flutter SDK-dan birr papkasi

ca yo'Ini Kiritish kmfz‘;‘ Kiritgy
“orasm);

émw;

== el

= 5-casm, hin papkasiga yo'Ini Kiritish

 Flutter fog'ri o°matilganligini tekshirish uchun buyrug qatorini
ochish 'va‘ﬂul’terbuymgfix_li‘kiriﬁsh kerak. Agar Wi

ndows bu buyrugni tanisa

va ba'zi yordam malumotlanm ko'rsatsa (masalan, konsolda ma’lum

ruglardan

ganday foydalanish kerak). u holda Flutter o*matilgan va

ozlangan hisoblanadi (7.6-rasm).

7.6-rasm.

Flutter to*g‘ri o‘rnatilganligini tekshirish
258

ootish oA ¥

an bir qator
.+ oshirish ue

‘da. Flutter SDK ni ‘Git orgali
d orqalt o' matish v
S s atish mur
hun SL)F'\ joy |d§hgfn_\ papkaga buyruq satri :\_"“,n“
cevin buyruq satrida quyidagi buyrugni bajarish kerak: qali

it clone _p stable hltps:.";'gilh\lb.CO\\\."“nllcrv"ﬂuucr.g“

punday holda, Flutter S

yuklab ol
Gitfor

inadi- U shbu buyruq

DK ning 50 nggl versiyasi GitHub omboridar
: haiaris ~ - v 1
ni bajarish uchun yuqorida aytib o‘tilganidek

Windows dasturini o*matish kerak.

Fhlm"""i MacOS-§20 ‘ruatish

l-'lutfer-ni ornatish va yang il

ash uchun git-dan foydalaniladi. shuning

fun gir.ni o rnatish kerak. Biroq. agar Xeode o matiigan bo'lsa, gir-ni
pchv . g2

-maﬁSh sh
Flutter

gDK-ni

art CMAs, chunki Xcode gif-ni 0°7 ichiga oladi.

o' rnatish uchun

hitps://flutter.dev/docs/get-

. call/MAcos sayliga o'tish va sahifadagi Flutter SDK havolasini

¥

ropish va unt ¥

lish kerak (7.7-rasm):

:
|

&

acl

—
—

—-u:~;'~ il Fhatie % = a ll
L @ A fumerdey(aige A 2w ow =@ ¢
P A > -\
'( Flutter o0 \

r
l

Keyinchalik, Flutter S
joylashtirish kerak.
foydalanuyehining tub papkasida (Users/Gost) joylashgan.

Terminalda
o'zgaruychilariga
ferminal oynasi uc

7.7-rasm.

Get the Flutter SDK

1. pownload the following ns1aiiaiion bundie 1o gat he |

{alast stable release of tha Flutier SOK

\ ﬂu!w_n“cos_lo.o-ntauo.:ip

For other rekwase channels, and older bulds, see tha

o~ o - 2 |
SHK relasoes pape |

2 Extract the file 10 tha desired 1ocation, for axampie \

.l

MacOS uchun Flutter SDK-ni yuklab olish

DK bilan jildni gattiq diskining biror joyiga
| uchun, bu holda, Flutter SDK  joriy

Miso

Flutter SDK  dan foydalanish  uchun fizim
SDK ichidagi bin papkasiga yo'Ini qo*shish kerak. Joriy
hun qo‘shish quyidagicha amalga oshiriladi:

259
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c“’mﬂ PA "“::-c'S"A"‘, 'l FIU"C" Sl)l\ l"(llgd Y()'”/""“ /b
: er/bin®

Flutter buyrug*ini birinehi marta ishlatganda, Dart SDK
B Yuklangd;
Aladj

Flutter-m ) ungilash

Agar [ lutter-ni yangilash kerak bo'lsa, buyruq satrid
» Arcia "Ill\-‘

Yidapg

]

buyvrugnt bajurish keruk:

fMutter upgrade
Flutter faol rivo_jluml_vomunHg.i sababli uni muntazam vanei
yaxshiroqdir. Flutier SDK ni o'matgandan so‘ng birinchi ';'j";f"
Oddry

yaratishni ko'rib chigamiz,
Windows wchay dastur yars wish
Avvalo, Flutter loyihalari uchun lokal diskda  Katalc
Masalan, ¢ [fluttersre Katalogi. Atiog  yaratilag,
CMD konsolida cd buyrug'i yordamida yaratilgan Katal
kerak, Keyin quyidagi buyruqni Kiritish lozim (7.8-rasm): DERA 0'tish
flutter create myapp

ab turig),
dastury;

7.8-rasm. CMD konsolida buyrugni Kiritish
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\pkada nryapy? aomli loyihani _\um\.ul'\ Natijada
{ < . X I
; 7.9-rasm).

jorsy PHE o
B bUY‘f“.“ 4 4 o joyiha yur.mhuh (7
shi e
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| e
g prvers
il
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gt e
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- S

7 9-rasm. myapp loyihasi tarkibi

ishining asos1y clementlarn quy idagilar:

asi foydalanilgan paketlar haqidagi ma’ lumotiarmi

|.oyiha fuzil
_ dart-tool papk

digan maxsus papkadir:
»'z ichiga olgan Android Studio

saqlay g .
asosiy konfiguratsiyani €

 idea papkast

ychun Maxsus papkadir:
— android pupkﬂsida Dart ilovasini Android bilan bog ' tash imkonini

beruvchi kod va qo'shimeha fayllar mavjud:
_ ios papkasida Dart flovasini i0S bilan bog’ lash imkonini beruvehi kod
va qo'shimcha fayllar mavjud:

_ build papkasida ilovalarni yaratish }
fayllar mavjud;

- [ib papkasida haqigiy Dart flovasi fayllari mavjud. Flutterda ilova
yaratishda asosly ish aynan shu papka yordamida amalga oshiriladi:

_ fest papkasi testlar bilan fayllami saqlash uchun mo*ljallangan:
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i ishga ushirish uchun buyrie] satriga o'tib cd buyrug'
ga otish lozim. Keyin loyihani ishga tushirish va

_ web papkada Flutter-da web-ilovani - yaratish uchyy
go'shimeba fayllar mavjuc: R i Layihani s
= P o ra)'{l foyine konﬁgfxram)as!m, xususan. loyiha Pakeg; rd"u';lidn mapr katalogi
pog-lighiklar ro‘yxatini va boshq.a!amx ssqla:vdn; €linj, <1 ~i;iugi huyrugni kiritish lozim (7.11-rasm):
Ushibu loyihada ishga tushirish mumkin bo*lgan minimal funksiy I quy futter run
i Yalar
mavjud.
tlash uchun emulyatorlar yoki haqj
B Iqj.\.

{lovani ishga tushirish va tes
qurilmalardan foydalanish mumKin. Flutter-da  web-ilovalarn;
wshirish uchun brauzerlar shartli “qurilmalar™ sifatida ishlatilad; Ishga

dash uchun — jorly kompyuter ishlatiladi. » Ishch;

stoli ilovalarini tes
Loyihani ishga tushirishda qurilma mavjudligini tekshirish
satrida quyidag chup
flutter devices

i buyrugni bajarish mumKkin (7.10-rasm):

7 11-rasm. Loyihani ishga tushirish
a papkasidan kompilyatsiya qilish va ishea

Android qurilmasiga o matiladigan
ladi. Birinchi marta ilova ishga
m etishi mumkin. Natijada,

pasturni har doim loyih
qushirish kerak. Natijada ulangan
lingan apk paketi paydo bo’

kompily atsiva qi
ulyatsiya jarayoni uzoq davo
angan qurilmada ishga tushadi (7.12-rasm).

7.10-rasm. Qurilma mavjudligini
Shunday qglib,knnsbomla test nc{mn achta “qurilma™ borligini mshirilganidfl el St
ko'rish mumkin. Birinchisi. Android ilovasini testlash uchun mo'ljallangan standart tarkibga ega tlovau
akslangan. Qolgan ikkita qurilma esa Chrome va

Nexus 5X mobil quritmasi

Microsoft Fdge web-ilovalarini testlash uchun mo’ljallangan, Shuni
ta'kidlash kerakki, skrinshotdan ko'rinib turibdiki, Google Chrome
brauzeriga “chrome™ matn belgisi. Microsoft Edge-ga esa “edge”, Nexus SX
uchun esa “013a70d5bc970c2¢™ yorlig*i berilgan. Ushbu belgilar ma’lum
bir qurilmada loyihani ishga tushirishga imkon beradi. Odatda ro"yxatdagi
birinchi qurilma tanlanadi.

Android-da ilovani ishga tushirish
Mobil qurilmani testdan o'tkazish uchun drayverni o°matish kerak.

Agar Windows 10 OT bolsa, unda, tizimning 0°zi drayvemi yangilash

ma'rkazi orgali topishi va uni o°matishi mumkin. Shuningdek, Google Usb

Driver pakctini ham o*matish kerak. Ushbu paketni Android SDK Manager

or'(';al! q'matish mumkin. Bundan tashqari, mobil qurilmada ishlab chigish

rejimini va USB orqgali nosozliklarni tuzatishni yoqish kerak.
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7 19-rasm. Android Studio-ning boshlang ich ckmnid_a New Fiyg
Project tugmachasini ko rinishi e
Flutter uchun loyiha yaratish uchun ushbu New Fluier py,
\iamasi bosiladi. Muqobil sifatida Android Studio-da loyia yaratish uchgy
menyu bandiga o'tish mumkin File -> New -= New Fluter Project (7 ]wL;)n

rasm):

7.20-rasm. Flutter uchun loyiha yaratishning mugobil varianti
Keyin yangi loyiha yaratish oynasi ochiladi. Chap tomonda Flutter
elementini tanlash va markazda Flutter SDK yo~li maydonida Flutter SDK -
ga yo'Ini ko*rsatish lozim (7.21-rasm):
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7.21-rasm. Flutter SDK ga yo©Ini ko rsatish

Keyingi oynada bir qator loyiha sozlamalarini kiritish lozim (7.22-

rasm):

7.22-rasm. Loyiha sozlamalarini Kiritish
Loyiha nomi maydonida loyihaga nom berish lozim. Shunday qilib,

bu loyiha hello_app deb nomlanadi.
Project location maydonida, agar taklif qilingan standart joy qonigarli

bo*Imasa, loyiha manzilini o*zgartirish mumkin.
271



Deseription maydonida loyiha tavsifini belgilash mumk;, ,
Project (ipe maydoni lo_v_iha turini belgilaydi. Odag da"
givmati o-rnatiladi (ya’ni loyiha ilova yaratish uchun mo*ljaflap
qiymaini sid

ndart sifatida belgilanadi.
(Organiz

APPliccy; oaadek.  Android  qurilmani
2an), [_;;;]"7/7 <mul¥§::’lrl$%nn foydalz\ni:sh mumkin) va An:;:)(l\:g\::;'drlk\'\l : l\\:—»\h (yoki
ation maydonida ilovalar paketi nomini belgilash ishga tushirish uchun yashil uchburchak bosiladi (7 34.::,\11‘:».““‘& Fovan
Taklif gilingan nomni goldirish yoki o*zgartirish mumkin, Mis Mum;,
com.doshanova. sol uchyy
Android language maydoni Android uchun tilni belgilayd; a ;
ham standart giymatni goldirish mumkin — Kotlin. i

Fhittter Derrra Home Hage
U yerdy
;0S language maydoni iOS platformasi uchun tilni be]
yerda ham standart

b
giymatni goldirish mumkin — Siwif?, gilaydi. By
Plagorms maydonida loyiha yaratiladigan platformalarni p
mumkin. Odatda. Android va iOS punktlari belgilanadi,

Clgilasy,
: ; lash mumki it o
mavjud platformalarni ham tanlash mumkin. Shunday gilib, yy 1a
skrinshotda ko*rinib turibdiki, web uchun loy iha yaratish
tanlash lozim.

) qoridﬂa’_i
da “Webh> bandi;;i
Keyin barcha sozlamalarni o‘matgandan so’ng, loyihani to*grig

to’g ri yaratish uchun “Finish™ tugmasi bosiladi. Yaratilgandan s;o‘m; dar::n-
Android Studio yaratilgan loyihani ochadi (7.23-rasm): Braiol

5
7.24-rasm. Android qurilmada ilovaning ko'rinishi

Xuddi shunday. Android Studio-da boshga “qurilmalarda™. masalan

web brauzerda loyihani ishga tushirish mumkin. Buning uchun asbeblar
panelid

a tegishli qurilmani tanlash kifoya (7.25-rasm):

7.23-rasm. Android Studio-da yaratilgan yangi loyihani ko rinishi

7.25-rasm. llovani ishga tushirish uchun gurilmani tanlash
i el Visual Studio Code-da birinchi ilova yaratish
| .Yamulgfu.l loyiha konsolda flutter create buyrug®i yordamida “m
y j;r'anlgan tuthshgg ega bo'ladi. main.dart fayli haqiqiy dastur kodini 0z
ichiga olgan Android Studio markazida ochiladi.

Bugungi kunda eng mashhur matn muharrirlaridan biri bu Visual
Studio Code hisoblanadi va Google buning uchun Flutterda ishlab chigish
plaginini taqd

im etadi. Uni o‘rnatish uchun View -> Extensions menyu
bandiga o‘tish lozim (7.26-rasm).

L
~3
o
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ida sfjutter” so'zi kiritiladi va natijalar orasidan Flutter: New

, ovnas =
uy B oject tanlanadi (7.28-rasm).

idir {
¥ 100 wion £

App!

ILSpy -NET Decor

Crri+ Shufe + x

7.28-rasm. Flutter: New Application Project ni tanlash

Keyingi gadamda yangi oynada loyiha joylashgan papka tanlanadi

=3

(7_39-msm): =N Ao

[[Q ewbop mancn R x| ‘
L : . AT v | Tiumoe iterue |
7.26-rasm. View -= Extensions menyu bandiga o tish < - A Lc:_\ﬂaf«?t_ - G g i |
Shundan so‘ng, kengaytmalar paneli ochiladi. Qidiruv may donigg ynopaaoine v Hasen panks ; = 9 \ "
“Flutter” so°zini kiritiladi (7.27-rasm): = | - Davs wonsvenisa o "
e BaecTpuIi OCTYT et 14002020 1101 ":m..\
@ OneDrive '
|
g Cere \\
< e > ~WRSE SRS, ) N
p———— ———
Manxa: | fluttersee =es |
L___ |__Selecta folder to creste the projectin_ | | Owems |

7.29-rasm. Loyiha joylashgan papkani tanlash

7.27-rasm. Flutter plaginini gidirish

Keyin yangi oynada loyiha nomi kiritiladi, masalan, “hello_app” va

Kerakli “Flutter” plagin topilgandan so‘ng uni o‘rnatish uchun Enter tugmasi bosiladi (7.30-rasm).

“O rnatish™ tugmasi bosiladi.

Ushbu plagin Dart plaginiga bog'lig bo*lgani uchun Dart plagini ham
avtomatik ravishda o‘matiladi.

Plaginni o‘matgandan so'ng, birinchi loyihani yaratamiz. Buning
uchun menyuning View -> Command Palette bandiga o‘tiladi. Ochilgan
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7 30-rasm. Loy iha nomini Kiritish

1ga ega bo'lgan loyiha yaratiladi, v,
5 1 f s
. Va

di shunday tuzilist
31-rasm).

Natijada, xud
arrirda ochiladi (7

ayli muh

main.dart 1

goverr ide
t build(

Visual Studio Code-dagi ko*rinishi

7.31-rasm. Loyihaning

bil qurilmasini kompyulerga
. Start Debugging menyusi
il varianti Run --

[lovani ishga tushirish uchun Android mo
ulash. lozim va Visual Studic Code-da Run --
be?'ndlga o‘tiladi. Loyihani ishga tushirishning mugob
Without Debugging buyrug'ini bajarish kerak (7.32-rasm)
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>

St Debuggvd

i 1shga tushirish

<

Withou! Debugs

sing orgali 10¥ ihan
a qilish uchun tepada
h ma‘lumm\m'\m

un -~

4 32-rasm. R
da otladk

nosozliklarnit tuzatis
ishga tushiriladi

Nalijada, lova yig,‘i\adk vs Code-
el ku'rsaliladi ya pastda €54 'bnrchu
% di. lova esd mobil qur\lmada

(7.33-rasm).

ko’ rsald

g L

o P bt e W

7 33-rasm. llovaning ishga tushishi
indows uchun ilova yaratish
120 versiyasidan boshlab Flutter freymworki Windows OT uchun
alar yaratishni Qo llab-quvvatlaydi. Biroq, freymworkn'mg o'ziga

shda, Windows OT-ga Jlovalar yaratish uchun bir qator
|

dalanib, “C++ da Klassik ilovalar \

Flutter yordamida W

ilov
qo‘shimeha ravi
gadamlai bajarish kerak:

Visual Studio o*atuvchisidan foy

ishlab chigish” ni tanlash lozim (7.34-rasm). \
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